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Objective:

e Learn the difference between a rasterized file and vector file

e Clip art file formats are divided into 2 different types: bitmap or vector graphics
o Bitmap or “rasterized” file formats are used to describe images made up of a grid of
multicolored or black and white pixels. Bitmap images are always limited in quality by
their resolution, which must be fixed at the time the file is created by increasing the

resolution.
=  Most common web-based file formats such as GIF, JPEG, PNG, BMP, TGA and
TIFF

o Vector file formats are mathematical calculations that form shapes. Because a vector
image is described using geometric data instead of fixed pixels, the image can be scaled to
any size while retaining "resolution independence", meaning that the image can be
printed at the highest resolution a printer supports, resulting in a clear, crisp image.

e Inessence, vector images are infinitely scalable without pixilation.

Bitmap Pixilation

E——
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Objective:

e Learn how to make a new document and what lives on the ‘New Document’ screen
e The start screen appears when there are no documents currently open in Illustrator. It lists your
recent files, learn content, and presets. You can also search Adobe Stock from here.

1. Open Adobe lllustrator — ‘Create New’

a. Atthe top of the window you will see preset options to choose from Adobe Stock.

(‘Mobile’ ‘Web’ ‘Print’ etc.) Under each tab will be free templates to download and edit.
2. Choose the type of Document (most times it will be ‘Letter’- 8 %5 x 11 inches) - Name your
document - Make sure ‘Units’ are in inches or centimeters

a. Change ‘Color Mode’ if needed (‘CMYK Color’ is for printing, ‘RGB Color’ is for Web or
Computer Screen Optimization)

b. ‘Bleed’ is the outermost parts of the artboard that act as margins. This is important if
you would like to print a poster at a specific size and not worry about the edges getting
cut off.

¢. You can access and edit all of this information in the ‘Properties Panel’ once the
document has been created.

Untitled-1

3. Reset your workspace: Choose ‘Essentials Classic’ and then ‘Essentials’ (This guide will be set in
an ‘Essentials’ workspace) — Next make sure to select ‘Reset Essentials’ under the same menu to

have a clean workspace.

Essentials Classic v jors

Essentials v £,

Properties Layers Libraries

© . Layer 1
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4. Show Rulers: ‘View’ — ‘Rulers’ — ‘Show Rulers’ (Rulers will be in the unit you set the document)

Select Effect MYEYE Window Help

View using CPU $BE
Outline 8Y
Overprint Preview TQSY Style: - v Document Setup Preferences =
Pixel Preview X &Y

Trim View

Presentation Mode

Proof Setup >
Proof Colors
Zoom In 8+
Zoom Out #-
Fit Artboard in Window 80
Fit All in Window X380
Actual Size 81
Hide Edges 8H
Show Slices
Lock Slices
Hide Artboards 0 8H
Show Print Tiling
Hide Te
Hide Bounding Box 8B
Show Transparency Grid  {+3D
Rulers > Show Rulers ¥R
Show Live Paint Gaps Change to Global Rulers 3R
Hide Gradient Annotator 3G Show Video Rulers
Hide Corner Widget
Hide Text Threads 0®Y
v Smart Guides #U
Perspective Grid >

5. Activate Smart Guides: ‘View’ — ‘Smart Guides’
a. Smart guides are magenta display lines that show up near objects. They are temporary
snap-to guides that appear when you create or manipulate object. They help you align,
edit, and transform objects relative to other objects by snap-aligning and displaying X
and Y locations.
6. Fit Art Board to Window: ‘View’ — ‘Fit Artboard in Window’
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Objective:

e Learn general terms used for the Illustrator Workspace

(3

° #® =~ Adobe Illustrator 2019

llustrator File Edit Object Type Select Effect View Window Help @ O GZE 0 100%BF Mond6PM Q @

X Untitled-2* @ 61.9% (CMYK/GPU Preview)

FARNEPIDANOS™Y YV

e Menu bar (at the very top) shows the ‘File’, ‘Edit’, ‘Object’, etc. These give you access to a variety
of commands, adjustments, settings, and panels.

e Tools Panel (on the left) contains tools for creating and editing artwork. Similar tools are grouped
together. You can access them by left clicking OR click and holding a tool in the ‘Tools Panel’.

e Panels (on the right) include ‘Properties’, ‘Layers’, and other panels that contain a variety of
controls for working with artwork. You can find a full list of other panels under the ‘Window’
menu. Panels in the ‘Window’ menu can be added to the panels dock on the right or left freely
floating in the ‘Document Window’.

e Document Window (in the middle) displays the file you’re currently working on. Multiple open
documents appear as tabs at the top of the ‘Document Window’.

e Artboard (white “page” in the middle) is where you will create your artwork.

e lllustrator has a very customizable workspace if there is a tool you cannot find in the
‘Tools Panel’ select ‘Edit Toolbar...” (three dots at the bottom of the toolbar) and a list
of all tools are available for you to place in the ‘Tools Panel’.
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Selection Tool (V)

Direct Selection Tool (A)
Pen Tool (P)

Curvature Tool (Shift + ‘)
Rectangle Tool (M)
Paintbrush Tool (B)
Type Tool (T)

Rotate Tool (R)

Eraser Tool (Shift + E)
Shape Builder Tool (Shift + M)
Gradient Tool (G)

Eyedropper Tool (1)

Width Tool (Shift + W)
Blend Tool (W)
Artboard Tool (Shift + O)

Zoom Tool (2)

Stroke and Fill Colors

Drawing Mode (Shift + D to switch modes)

Change Screen Mode (F)

Edit Toolbar...
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Objective:
e Learn how to place an image in an lllustrator File.

e You can use this skill to place images in brochures or place an image outside of the artboard as

reference while drawing. =™ Edit Object Type Selec
New... 8N
New from Template... £ 8N
e When you have an image saved to your computer select “File” — Open... 380
“ ” Open Recent Files >
Place... Browse in Bridge... X 0
e From here a dialog box will pop up so you can browse your Close BW
computer to select an image e =S
P ge. Save As... %S
m~v | E Demo Files < Q Save a Copy... %S
- Save as Template...
Favorites Bl 8d66eb17bb...6fe24ff2.jpeg 3
—— : 267311556_2.jpg Save Selected Slices...
audifonos-vi...022016-F |
[ Desktop @ download.jpeg e Revert
Edcoogenrive T Jhee dont R Search Adobe Stock...
Bo 2 old-headpho..-2092628 jpg Place... 3P
E Recents
A\ Applications Export S
© oownloads Export Selection...
@ Creative Cloud...
loud Pac.kage... X {38P
& icloud Drive Scripts | 2
o Document Setup... 58P
Enable: All Readable Documents a Document Color Mode | 2
v Show Import Options File Info... Aty 4|
Options Cancel Print... #P

e Once you place the image on or next to the artboard you can

Properties Layers Libraries

move and resize the image by activating the Selection Tool (V)

Image

Transform

in the Tools Panel. Shift-drag a corner to resize the
image without distorting the proportions. When
. . X: 3.201in  W: 3.637in
finished, release the mouse button and then the Shift key.
Y: 3.329in H: 4.504 in

e Click the Crop Image button in the Properties panel on the right Lige o

side of the document to crop parts of an image.

Appearance

Quick Actions

Unembed Mask

Crop Image Image Trace

Arrange
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e Drag any handle around the image Properties Libraries
to remove an unwanted portion.

Click Apply in the Properties panel.

Layers
Cropping
Transform
e HINT: 229
o Make sure to always save the photo

X: 3.951in W: 3.635in

Y: 5.33in H: 4.503in

PPI: 247 ~
until you are finished with the

Quick Actions

document. If you move the file to a

Cancel

Apply

new folder you will need to “replace”
the image. AKA find it and place it again.

e If you would like to use the images as a reference you can lock them in the background by
activating the object with the Selection Tool (V) and going to “Object” — “Lock” —
This will make it so you cannot edit the locked selection unless you unlock it.

“Unlock All”

“Lock Selection”.

e To unlock something go to “Object” —

Type Select Effect View Window Help Type Select Effect
Transform > Transform >
Arrange » Arrange >
Align Align >
Group Group #G
Ungroup Ungroup {86

Selection 82 Lock >
Unlock All All Artwork Above Unlock All 382
Hide > Other Layers Hide >
Show All 3 | Show All 383
Created by: Lexi Voss 9
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Objective:
e Learn how to add a line of text, paragraph of text
e Learn how to change fonts and font size

e Activate the ‘Text Tool’ in the toolbar to the left. Simply click on the artboard to add
some text. A small line of “place holder” text should appear and can be replaced.
o The ‘Text Tool’ is great for titles and headlines
e Toadd a paragraph of text, select the ‘Text Tool’ and click and drag to make a text box.
By clicking and dragging the text will wrap to fit within the box.
e With the text highlighted you can start typing to add your own text.
e To move and resize the text select the ‘Selection Tool (V)" and edit it as you would a
shape.
o To keep the text dimensions the while using the ‘Selection Tool’ to resize press
and hold the ‘Shift Key’
o You can also change the font and font size in
the ‘Properties Panel’ to the far right of the
document.

Properties Layers Libraries

Characters

Transform o To change the color of the text double click the

X: 385.4722 - 29.2314 . .
: ‘Fill Color’ and apply color like you would to a shape
y: 88.0288 . 13.0439¢

4: 0° ~ Did Z

Appearance
] Fi
L" Stroke

Character

Q> Myriad Pro Font
Regular

Font Size 2 12pt

Quick Actions

Create Outlines
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Objective:

e Learn how to create and edit basic shapes using the shape tools

e When you draw shapes, Smart Guides (‘View’ — ‘Smart Guides’) help by showing the
shape and size in a grey measurement label, snapping to other objects, and indicating
when an ellipse is a perfect circle or when a rectangle is a perfect square with magenta
lines.

e Most shapes are Live, which means you can edit them without switching tools after
drawing. Different shapes have widgets for editing corner radius, number of sides and
more.

e To show other shape tools, click and hold the ‘Rectangle Tool (M)’ in the Tools PaneI‘

e When you click on a shape with the ‘Selection Tool (V)" a ‘Bounding Box’ appears. This
allows you to edit shapes.

e With the ‘Selection Tool’ active you can move a shape by clicking and dragging the
circle/square in the center of the shape.

; -) ' ' Click and drag the solid boxes in the corner to
' resize

Click and drag the widget in the corners of
the box toward the center to round the
corners

Hover your mouse near the corner of the
square (with the ‘Selection Tool’ still

. =) active) once the mouse turns into a curved
line with arrows on either end you can
rotate the selected shape

®
®
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e Press and hold the ‘Rectangle Tool’ to choose from different - O
shapes. If you would like a polygon that is not shown in the @ Ellipse Tool
menu select the ‘Polygon Tool’
o HINTS:
» The ‘Polygon Tool’ draws shapes from the center
» Press and hold the shift key to straighten

{ Polygon Tool
i} Star Tool
/  Line Segment Tool (\)

e The ‘Polygon Tool’ has similar widget features to the square. (IE: Moving, Rotating,
Rounding Corners, and Resizing)

[} {k {1
© Press and drag the diamond up
and down the right side of the
L ° bounding box to change the
number of sides the polygon
has.
! ', 0

e Another way you can make simple shapes is by the ‘Shaper Tool (Shift + N)’. If you
click and hold the ‘Shape Boolean Tool’ you can access the ‘Shaper Tool’. This tool
allows you to click and draw a basic shape. Once you let go of the mouse
Illustrator will interpret your drawing turn it into a perfect polygon. —

3

(M (/ shaper Tool (Shift+N)
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Objective:

e Learn how to draw lines and paths with the ‘Line Segment . B Rectangle

Tool (/) “‘Arc Tool’ and the ‘Pen Tool (P) 1

e Learn how to edit and reshape lines and paths with the
‘Selection Tool (V)’ and the ‘Direct Selection Tool (A)’

O Ellipse Tool

{ Polygon Tool
Y Star Tool

e Alinein lllustrator is called a path which is composed of at / Line Segment Tool (\)

least two anchor points, a start and an end anchor point.

e Draw straight lines using the ‘Line Segment Tool (/)’.
Select the ‘Line Segment Tool (/)" by clicking and
holding the ‘Rectangle Tool’ in the tools panel.

o Hint:

Properties Layers Libraries
Line

. . . Transform
»= Lines segments are “Live”, which

means you can edit the length, X: 1.741in W: 0.932in
direction, and angle after drawing §§§

them without switching from
the ‘Line Segment Tool’ to a 4 302.6; v
selection tool.

Y: 1.053in H: 1.456 in

e Rotate a line by moving the pointer off an end and
dragging. Appearance

e Once you have selected the ‘Line Segment Tool (/) n Fill
Press and drag. Once you release the mouse you
will make the line. (The grey box following your
cursor has the length and angle of the line.)

|:| Opacity  100%

e To edit the direction and length of the line move
your mouse to one of the ends (or anchor points). fx.
Click and drag and you will see you can change the
direction of the line.

o HINT:

»= Press and hold the shift key as you
drag, and the line will be Offset Path Expand Shape
constrained to 45°

e To move the line, drag it from the center point.

Quick Actions

Arrange

Recolor

e To change how thick the line is you will need to
change what is call the ‘Stroke’ in the ‘Properties
Panel’ on the right.

e You can also change the color of the line by double clicking the box to the left of ‘Stroke’. (The
next section will explain more about how to navigate the color options.)

Start Global Edit

Created by: Lexi Voss 13
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‘—____. W i

[O] stroke T lpt -~

@ Weight: | C v 100% >

v

N
(— -
- WA Corner: If £F £F Limit: 10

‘ Align Stroke: &=

[C) Dashed Line

Expand Shape

e To make the line segment an arrow, click the
word ‘Stroke’ in the ‘Properties Panel’.

e Inthe ‘Stroke’ dialog box you can change the IR — R —
weight of the line, direction of the arrow, and arGloballedit
make a dashed line.

Arrange

Recolor

e You can also create an Arc by using the ‘Arc Tool’. In the R4
‘Essentials’ workspace the ‘Arc Tool’ is under the i [#7 Blob Brush Tool (Shift+B)
‘Paintbrush Tool’ menu. 4 Pencil Tool N

o If you cannot find it in your toolbar remember
you can add tools to the toolbar by clicking the
three dots at the bottom.

&‘ /~ Arc Tool

e Once you have an arc drawn it can be edited by using the ‘Selection Tool (V)’ or the ‘Direct
Selection Tool (A)'.
o The ‘Selection Tool (V)’ allows you to move the arc and
transform it like you would a shape through the selecting
points in the bounding box and resizing it. If you hover
on a corner of the arc’s bounding box you can also Anchor Point q
rotate the object with the ‘Selection Tool’.

o The ‘Direct Selection Tool (A)’ allows you to edit
the anchor points of an object. The anchor points
are the start and end of the arc (a line or arc can have
more than two anchor points). With the ‘Direct Selection = Handle
Tool’” anchor points can be moved individually to change the
shape of the arc. You can also change the curvature of the arc by
moving the handles

* Anchor points are square boxes and handles are the circles
at the end of a line that comes off of the anchor point.

Created by: Lexi Voss 14
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.
e Another way to create a closed shape with straight lines is to use the ‘Pen Tool (P)’.

S
e Tocreate a curved shape out of lines you will use the ‘Curvature Tool (Shift + ‘).

o Both tools allow you to draw a continuous line by clicking to create ‘anchor points’ you
can make as many anchor points as you would like. Once you click the anchor point you
started with the shape will close.

o You can edit the line you create with the ‘Direct Selection Tool’ by moving anchor
points and handles.

Here you can see a shape that was made with the ‘Curvature Tool’.
Once selected with the ‘Direct Selection Tool’ you can edit the line
by moving anchor points and handles.

Created by: Lexi Voss 15
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Objective:
e Learn how apply color to artwork using existing colors and colors you create.
e Learn how to save a color you create as a swatch for later use.
e Learn how to create, edit, and apply custom gradients.

e Activate the ‘Selection Tool (V) on the left and click to select a shape you have drawn.
e Shapes and text can have a ‘Fill’ and a ‘Stroke’ color.
e Forthe shape below, the pink color is the ‘Fill’ and the yellow color is the ‘Stroke’ or border. The

‘Fill’ or ‘Stroke’ can be a color, gradient, or pattern.
Properties Layers Libraries

Rectangle

Transform
X: 4.366 in W: 1.491in
Y: 2.477 in H: 1.491in

4 o° v

Appearance

e You can change the ‘Fill Color’ and ‘Stroke Color’ in the
‘Properties Panel’ to the right of the document when you
have an item selected. Clicking the square to the left of ‘Fill’
will open a box that has default saved colors called
‘Swatches’.

Quick Actions
Appearance

] i

Offset Path Expand Shape

S 12pt v Arrange

v

Opacity  100% > Recolor

Start Global Edit

ck Actions

Offset Path Expand

Arrange

Recolor

Created by: Lexi Voss 16
lexivoss@upenn.edu
University of Pennsylvania



e There is also an option for mixing or creating your own colors by choosing a location of the color
palette. (HINT: If you have the CMYK or RGB data you can input that into the color palette to get
an exact color.)

Appearance

[] Fi

Offset Path Expand

Arrange

Recolor

e Thereis also an option to use the ‘Color Picker’ to select a color. You can access this by m A

double clicking the ‘Stroke’ or ‘Fill’ Box in the toolbar on the left. Once you do that the
dialog box below will pop up. You can use the ‘Color Picker’ to create a custom color I:‘a

visually by entering color values, or by choosing from a library of colors.
| 4/

Color Picker

Select Color:

O H: 323°
Os: 100%

OB: 92%
OR: 236
OG: o

OB: 140

td EC008C

] Only Web Colors

e Making a custom color in the ‘Color Picker’ does not mean the color is saved to
apply to other objects. If you would like to apply the same formatting from one
object to another you must either write down the CMYK or RGB data OR use the
‘Eyedropper Tool (l)’.

e Inorder to make another object the same color you need to activate the ‘Selection Tool’ in the
Toolbar and then select the object you would like to change the color of. Once the object is
selected activate the ‘Eyedropper Tool (1)’ in the toolbar.

Created by: Lexi Voss 17
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e Select the ‘Gradient Tool (G)’ or double click the small gradient box below the ‘Fill’
and ‘Stroke’ boxes in the toolbar to add a gradient to an object.
e Once you have selected to add a gradient a ‘Gradient Panel’ will show up on the

artboard or in the panels on the right.

e You can edit the colors of the gradient by double clicking on the white or black

circles in the panel.

Gradient

0

. Tyee: [0 [W] [

Edit Gradient

Opacity: v
£y =N EEEEN
|

B =] IEEEE
CI

Gradient

. Tyee: [ (W] [

Edit Gradient

&

(’

Location: 16.7128% v

Created by: Lexi Voss
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The diamond above the gradient
bar allows you to change the
center of the gradient in the
object.
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Objective:

Appearance
e Learn how to access and change color palettes to apply to L Fin
your images [@ swoke O lpt ~
e Learn how to recolor artwork in a few steps using Recolor B Qece [10% |

Artwork. fx.

Quick Actions

e To access the ‘Recolor Artwork’ dialog box select ‘Recolor’ in
Offset Path Expand Shape

the ‘Properties’ panel to the right.

Arrange

e The dialog box will have all the colors in your document and

Recolor

will recommend a color palette based on the color selected.
Start Global Edit

e Below are color palettes based on the custom maroon color
selected

[ v Artwork colors Vd [~

Shades
Color Groups

> BN Crays
Triad 2
Triad 3 4 . Brights

Tetrad

Triad

Preset: Custom

Current Colors (2)

Tetrad 2

Tetrad 3

. Compound 1
. Compound 2
High Contrast 1

High Contrast 2

High Contrast 3

High Contrast 4

uuuuivivvevveeue

Pentagram

None

ER.
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e Recoloring your graphic is a useful tool to know when you want to try different color
palette, change the hue, or make the entire image lighter or darker.

1. Select the artwork to recolor.

2. Click the ‘Recolor’ button in the ‘Properties Panel’ to the right, to open the
‘Recolor Artwork’ dialog box.

3. Select the ‘Edit’ tab to view colors in the selected artwork in a color wheel.

o Onthe color wheel is colors the program picked up from the selected
artwork.

4. Dragindividual colors in the color wheel to edit them.

Recolor Artwork

v Artwork colors Vd

Assign Color Groups

> B Grays

> || Brights

per

Adjust
Brightness

[

B — 00.2 %

5. Click the ‘Eyedropper’ to get the original colors from the artwork again, if
needed.

6. Click the ‘Link Harmony Colors’ button to edit all of the colors together. Drag
individual colors in the color wheel to edit the colors together.

7. Click ‘OK’ to change the color for the selected artwork.

e Instead of editing the colors separately, the ‘Recolor Artwork’ feature gives you a

powerful way to edit a series of colors quickly and visually.
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Saving/Exporting

Obijective:

e Learn the different methods for saving/exporting your lllustrator projects

e Saving: “File” — “Save” OR “File” — “Save As”
o ”ii” OR “Adobe lllustrator Artwork”: preserves all data within document so that you can

edit later. Can only be viewed if you have Adobe lllustrator.

o ”.Qdf” OR “Portable Document Format”: saves document that is not editable but can be
opened by anyone with a free PDF reader.

o “.€PS” OR “Encapsulated Postscript”: which is a vector format used for printing to
postscript printers and image setters.

o “.ait” ORr “Adobe lllustrator Template”: another way to save an lllustrator file that is
good if you are making multiple iterations of a project.

o “<SVE” OR “Scalable Vector Graphics”: used to save image for use on website and in

print. Can be used in most places a .jpeg or other pixel-based images are used. (TIP: If .svg
is not an acceptable file format you can export the image as a .jpeg explained later.)

o “.SVEZ” OR “Compressed Scalable Vector Graphics”: smaller file size of .svg

Save As

Save As: | Untitled-2.ai ‘

Tags:

(O

Where: [ Documents

Format v Adobe lllustrator (ai) !
lllustrator EPS (eps)
lllustrator Template (ait)
Adobe PDF (pdf)

SVG Compressed (svgz) uT'

SVG (svg)

e “lllustrator Options”: When you save a document for the first time or save a document as a copy a
dialog box like the one below will pop up. This dialog box allows you to save the file as a format
that will allow you to open it in earlier versions of Illustrator (anything pre-Creative Cloud) among
other more advanced options. In many cases you can keep the default settings and click “OK”.

Created by: Lexi Voss 21
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e Exporting: “File” — “Export” — “Export As”

G Edit Object Type Select Effect View Window Help

New... #N Adobe il
New from Template... T %8N
Open... 80
Open Recent Files >
Browse in Bridge... X380
Close ®’W
Save 8S
Save As... %8S
Save a Copy... X %8S

Save as Template...
Save Selected Slices...
Revert

Search Adobe Stock...
Place... 3P
Export » Export for Screens... X $E
Export Selectio Export As...
= Save for Web (Legacy)... X{#S
Package... X1 #8P
Scripts >
Document Setup... X 8P
Document Color Mode >
File Info... X088l
Print... 8P

e If you have anything surrounding the Artboard that will be exported with your artwork.

Export

Save As: | Untitled-2.png

Tags:

Where: [® Documents v

Format v PNG (png) !

CSS (css)
AutoCAD Drawing (dwg)

AutoCAD Interchange File (dxf) m
Enhanced Metafile (emf)

"1 Flash (swf)

JPEG (jpg)
Macintosh PICT (pct)
Photoshop (psd)

Targa (TGA)

Text Format (txt)
Windows Metafile (wmf)
SVG (svg)

e Outlined below are explanations for the different file types and links to Adobe Illustrator’s Help
Page for further explanation on exporting that specific file type. Most likely you will use “.jpg”,
“.png”, or “.tif” for use in other commonly used Microsoft/Adobe applications.

o “.PNEL” OR “Portable Network Graphic”: Used for lossless compression and for display of
images on the web. Unlike GIF, PNG supports 24-bit images and produces background
transparency without jagged edges; however, some web browsers do not support PNG
images. PNG preserves transparency in grayscale and RGB images. For more information,
see PNG export options.
https://helpx.adobe.com/illustrator/using/exporting-artwork.html#png_export_options
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o “.BMP”oR “Bitmap”: A standard Windows image format. You can specify a color

model, resolution, and anti-alias setting for rasterizing the artwork, as well as a format
(Windows or 0S/2) and a bit depth to determine the total number of colors (or shades of
gray) that the image can contain. For 4-bit and 8-bit images using Windows format, you
can also specify RLE compression.

o “.CSS” OR “Cascading Style Sheet: used for HTML web design.

o) ".dwg" OR “AutoCAD Drawing”: the standard file format for saving vector graphics
created in AutoCAD. See AutoCAD export options.

https://helpx.adobe.com/illustrator/using/exporting-
artwork.html#autocad_export_options

o “.dxf” or “AutocAD Interchange File”: drawing interchange format for exporting

AutoCAD drawings to or importing drawings from other applications. See AutoCAD export

options. https://helpx.adobe.com/illustrator/using/exporting-
artwork.html#autocad_export_options

o “.emf” OR “Enhanced Metafile”: Widely used by Windows applications as an
interchange format for exporting vector graphics data. lllustrator may rasterize some
vector data when exporting artwork to EMF format.

o “.SWIF” OR “Flash”: A vector-based graphics format for interactive, animated web

graphics. You can export artwork to the Flash (SWF) format for use in web design, and
view the artwork in any browser equipped with the Flash Player plug-in. For more
information, see Flash export options.

https://helpx.adobe.com/illustrator/using/exporting-artwork.html#flash_export_options

o) "Jgg" OR “Joint Photographic Experts Group”: Commonly used to save photographs.

JPEG format retains all color information in an image but compresses file size by
selectively discarding data. JPEG is a standard format for displaying images over the web.
For more information, see JPEG export options.

https://helpx.adobe.com/illustrator/using/exporting-artwork.html#jpeg_export_options

o) ”.ECt" OR “Macintosh PICT”: Used with Mac OS graphics and page-layout applications to

transfer images between applications. PICT is especially effective at compressing images
with large areas of solid color.

o) ”.ESC'” OR “Photoshop”: The standard Photoshop format. If your artwork contains data

that cannot be exported to Photoshop format, lllustrator preserves the appearance of the
artwork by merging the layers in the document or by rasterizing the artwork. As a result,
there may be times when layers, sublayers, compound shapes, and editable text are not
preserved in the Photoshop file, even though you selected the appropriate export option.

For more information, see Photoshop export options.
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https://helpx.adobe.com/illustrator/using/exporting-
artwork.html#photoshop_export_options

o “tif" or “Tagged-Image File Format”: Used to exchange files between applications and

computer platforms. TIFF is a flexible bitmap image format supported by most paint,
image-editing, and page-layout applications. Most desktop scanners can produce TIFF
files. For more information, see TIFF export options.

https://helpx.adobe.com/illustrator/using/exporting-artwork.html#tiff_export_options

o “TGA” Designed for use on systems that use the Truevision® video board. You can
specify a color model, resolution, and anti-alias setting for rasterizing the artwork, as well
as a bit depth to determine the total number of colors (or shades of gray) that the image
can contain.

o “.IXt” OR “A Sstandard Text Document”: Used to export text in an illustration to a text
file.

o “Wmf” OR “Windows Metafile”: An intermediate exchange format for 16-bit Windows

applications. WMF format is supported by almost all Windows drawing and layout
programs. However, it has limited vector graphics support, and wherever possible, EMF
format should be used in place of WMF format.

o “.SVE"” OR “Scalable Vector Graphics”: used to save image for use on website and in

print. Can be used in most places a .jpeg or other pixel-based images are used
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BONUS: Default Keyboard Shortcuts

DOCUMENT SHORTCUTS

Undo

Redo

Cut

Copy

Paste

Paste in Front

Paste at Back

Check Spelling

Open the Keyboard Shortcuts
Dialog Box

Place a File in the Document
Save

Save As

Save a Copy of the Document

TOOL SHORTCUTS

WINDOWS

Ctrl+ 2

Shift + Ctrl + Z
Ctrl + X

Ctrl + C

Ctrl +V

Ctrl +F

Ctrl + B

Ctrl +1

Alt + Shift + Ctrl + K

Shift + Ctrl + P
Ctrl+S

Shift + Ctrl + S
Alt + Ctrl + S

MAC

Command +Z

Shift + Command + Z
Command + X

Command + C

Command +V

Command + F

Command + B

Command + 1

Option + Shift + Command + K

Shift + Command + P
Command + S

Shift + Command + S
Option + Command + S

Selection Tool

Direct Selection Tool
Pen Tool

Paint Brush Tool

Add Anchor Point Tool
Delete Anchor Point Tool
Type Tool

Line Segment
Rectangle Tool

Shaper Tool

Ellipse Tool

Free Transform Tool
Eyedropper Tool
Zoom Tool

Hand Tool
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o> <

B

+ (Plus)

- (Minus)

T

\ (Backslash)
M

Shift + N

T N — mr—

o> <

B

+ (Plus)

- (Minus)

T

\ (Backslash)
M

Shift + N

T N — mr—
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VIEW ARTWORK SHORTCUTS

Toggle Between Screen Modes:
Normal Screen Mode, Full
Screen Mode with the Menu
Bar, and Full Screen Mode
Exit Full Screen Mode

Fit Artboard in Window
Hand Tool (when not in text-
edit mode)

Hide Unselected Artwork
Show/Hide Artboard Rulers
Zoom In

Zoom Out

Hide Guides

Lock Guides

Show/Hide Smart Guides
Show Grid

WINDOWS

F

Esc
A
Press and hold the Spacebar

Ctrl + Alt + Shift + 3
Ctrl +R

Ctrl + =

Ctrl + -

Ctrl +;

Alt + Ctrl +;

Ctrl+ U

Ctrl +*

MAC

Esc
A
Press and hold the Spacebar

Command + Option + Shift + 3
Command + Option + R
Command + =

Command + -

Command +;

Option + Command +;
Command + U

Command + *

Export Keyboard Shortcut List as a Text Document

You can export the list of default and custom keyboard shortcuts for tool and menu commands in

Illustrator as a text document.

“Edit” — “Keyboard Shortcuts”
Click “Export Text” on the lower-left corner of the Keyboard Shortcuts dialog box.

1
2
3. Navigate to the desire location to save the text file.
4

Click Save.
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